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					Le tue domande più frequenti ... e le nostre soluzioni

Il nostro staff di supporto tecnico riceve ogni anno moltissime richieste dagli utenti Allplan e le soluzioni sono regolarmente archiviate in un database delle FAQ (Frequent Asked Questions).

In qualità di Cliente Serviceplus, tu hai diritto di accesso e ricerca in tutto l'archivio per trovare le risposte di cui hai bisogno.
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			Domanda: 

Come posso rimuovere completamente il software NemSLock da un computer?



Risposta:

A tal proposito procedi come segue:

	Disinstalla Nemetschek Softlock 2006 da Start -> Impostazioni -> Pannello di controllo -> Software.
[image: ]

	
	
Seleziona "Nemetschek SoftLock 2006" e fai clic su "Cambia / rimuovi". Nella finestra di setup seleziona "Rimuovi programma" -> Avanti -> Sì.

	Decomprimi il file allegato "NSLFixer2006.zip" e copialo in una cartella qualsiasi del tuo computer. Se il file allegato NSLFixer2006.zip è bloccato dal tuo provider e-mail oppure da un firewall, il file può anche essere scaricato dal nostro server FTP. A tal proposito utilizza il link seguente 
ftp://nemhotline:ha37jvg8f@ftp.nemetschek.de/download/Allgemein/NemSLock/NSLFixer2006.exe

	Avvia NSLFixer2006.exe con un doppio clic. 
Avviso importante:
se utilizzi Windows Vista (oppure un sistema operativo più recente), seleziona il file con un clic destro del mouse e fai clic su "Esegui come amministratore". Conferma il messaggio seguente con "Consenti".

	Crea il Key con "Generate/Enter a Key" (vedi screenshot 1.)
[image: ]

	

	Ora evidenzia la riga dietro "Generate/Enter a Key" (vedi screenshot 2), ad esempio, "1F02E74917D3F6E7348C1F02E74917D35E2599A254864A233C549A25ADD2EDFD" e premi la combinazione di tasti "Ctrl C". Ora incolla la Key dagli Appunti in una e-mail e inviala a "support.it@allplan.com".

	Riceverai da parte nostra una ulteriore Key da incollare nella seconda riga (vedi screenshot 3). Se il programma è stato riavviato, incolla nuovamente la Key che ci hai inviato nella prima riga (vedi punto 3 senza utilizzare nuovamente il pulsante "Generate/Enter a Key"!). Dopo aver incollato i dati premi "Validate twin key" (vedi screenshot 4) Successivamente dovrebbe apparire il messaggio "System cleaned. Reinstall NemSLock".

	Ora esegui un update dal DVD corrente di Allplan. A tal proposito, utilizza il tuo file licenza temporaneo (contiene un "psd" nel nome del file). Le tue licenze temporanee correnti si trovano anche su www.connect.allplan.com"PROFIL-> Gestione licenze".
Per eseguire l'update delle versioni scuola / studente utilizza il setup di Allplan disponibile come download nel portale Allplan Campus. All'occorrenza il download del setup può essere eseguito in ogni momento dal portale (http://www.allplan-campus.com -> login -> seleziona "Software" -> Download Allplan). Durante l'installazione utilizza la licenza Trial contenuta nel setup.


Il software Softlock può anche essere installato direttamente senza dover eseguire un Allplan Update completo. Informazioni in proposito si trovano qui http://connect.allplan.com/it/support/loesungen.html?tx_nemsolution_pi1%5BdokID%5D=0001cc7e.htmlhttps://connect.allplan.com/it/faqid/00031d36.html

Successivamente basta fare domanda di nuova licenza mediante l'invio di una nuova richiesta di registrazione (Allmenu -> Utility -> Licenza -> Gestione licenze). Evidenzia la licenza del tuo posto lavoro e fai clic su "Richiedi licenza". 
Se lavori con un License Server, riconnetti il client al server.
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			Domanda:

Quali schede grafiche sono consigliate per Allplan?



Risposta:


Al link riportato di seguito è disponibile l'elenco dei produttori di schede grafiche  AMD/ATI & NVidia con il nostro logo CERTIFIED AND RECOMMENDED. 
Sono state testate le funzionalità OpenGL e le performance in animazione per grandi quantità di dati generati dai diversi moduli di Allplan.
https://www.allplan.com/services/cad-software-support/grafikkarten.html

I driver testati si trovano sulle homepage dei rispettivi produttori. Per eseguire un confronto, nella tabella è indicata anche la versione dei driver utilizzati. Installare comunque sempreil driver del produttore.

Per verificare il proprio sistema, si consiglia di utilizzare Systemtool disponibile nella nostra homepage:
https://www.allplan.com/services/cad-software-support/downloads.html



Ulteriori informazioni: 

A partire da Allplan 2011, la gestione grafica del programma è stata completamente rivista e progettata per aumentare la velocità. 
A partire da questa versione, per poter sfruttare appieno le performance di Allplan è necessario che le schede grafiche abbiano i requisiti hardware previsti per le DirectX 10 & OpenGL 2.0 (chip-correlate) e che siano installati i driver aggiornati del produttore.  Se si dispone di una vecchia scheda grafica che non soddisfa i requisiti di sistema, all'avvio di Allplan viene automaticamente richiamato il precedente motore grafico.  

Informazioni dettagliate sulle specifiche delle schede grafiche si trovano in:

http://en.wikipedia.org/wiki/Comparison_of_AMD_graphics_processing_units
http://en.wikipedia.org/wiki/Comparison_of_NVIDIA_graphics_processing_units#Quadro)



Avviso:

La preghiamo di comprendere che non avendo alcuna esperienza sui prodotti di altri produttori non possiamo fare alcuna raccomandazione in merito.
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			Domanda:

Come posso convertire tutti i progetti in uno step unico dopo un upgrade?



Risposta:

Accertati che esista un backup dati di tutti i progetti!

Esegui i seguenti steps:

	Esci da Allplan su tutti i posti di lavoro.
	Solo se utilizzi il workgroup-manager:
Esegui un login come amministratore Allplan (sysadm).
	Avvia Allmenu
	Solo se utilizzi il workgroup-manager: 
Accertati che tutti i computer su cui sono salvati i progetti siano accesi.
Questo può essere verificato da:
Allmenu -> Workgroup-manager -> Informazioni -> Mostra elenco progettinella colonna di destra ci sono i computer su cui sono salvati i progetti).
	Sul computer dove deve essere eseguita la conversione, come dimensione quadro, imposta il valore più elevato:
Allmenu ->Assistenza ->Strumenti hotline->docsize ->512 (oppure, se disponibile, 1024) ->OK
Avviso:
dopo aver eseguito la conversione dei dati, riduci / ripristina il valore originale per la dimensione quadro.
	Avvia la conversione dati (solo dal computer dove è stata cambiata la dimensione quadro):
Allmenu ->Assistenza ->Strumenti hotline -> datwaprjs: Conversione dati di tutti i progetti
La conversione dati di tutti i progetti viene avviata confermando con "Sì" entrambi i messaggi successivi.




Avviso:

considera che la velocità di conversione dati dipende da diversi fattori:
	Numero progetti
	Dimensione progetti
	Velocità del computer in cui viene eseguita la conversione dati
	Velocità della rete


La conversione dati può essere eseguita contemporaneamente da più posti di lavoro.
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			Domanda:

Come posso eseguire l'export in DWG del mio layout tavola in modo tale che per ogni quadro venga salvato un ulteriore DWG referenziato?



Risposta:

A differenza di Allplan, AutoCAD ha un solo spazio costruzione (modello). AutoCAD non consente di lavorare in diversi spazi di costruzione come avviene per i quadri di Allplan. Per poter gestire dei file esterni referenziati è possibile caricare diversi DWG in un master DWG.    
In Allplan è disponibile un preferito di scambio specifico: "Export complesso da editor tavole con riferimenti esterni". 
Con questa variante, durante l'export della tavola viene creato un disegno principale (master tavola DWG) e ulteriori file (XRefs DWG) per tutti i quadri in essa contenuti. Questi ultimi sono collegati alla tavola master DWG e quindi visibili con essa. Questi file sono contenuti esclusivamente nell'area di costruzione (spazio modello) di AutoCAD. 

Procedura export:

Selezionare la tavola da esportare nel layout tavole
	Selezionare Menu: File -> Esporta -> Esporta dati AutoCAD...Selezionare la tavola e confermare con OK .
	Nella finestra seguente "Salva con nome", impostare in Salva inla cartella in cui si desidera salvare i file da esportare e selezionare il Tipo file.
	Selezionare il pulsante Opzioni... , la scheda 'Impostazioni generali'e impostare le opzioni desiderate. A partire da Allplan 2009 è ad esempio possibile selezionare come base di scambio il preferito 3 e impostare manualmente le altre opzioni.
Passare alla scheda 'AutoCAD specifiche'sotto Spazio file da trasferireCostruzione (spazio modello).
Effettuare eventuali altre impostazioni nelle opzioni e, al termine, confermarle con OK 
	Avviare quindi l'export con Salva
	Si apre la maschera "Export:..." per il layout tavole. Premere il pulsante Modificaper procedere alla modifica nella configurazione. Per ogni quadro utilizzato, nel processo di export, si apre nuovamente la maschera "Export:...".
	Viene scritto un master tavola DWG e un file DWG referenziato per ogni quadro


Risultato:

1. File creati:
Viene creato un file per la tavola (ad esempio "tavola_1.dwg) e un file per ogni quadro posizionato nella tavola come XRef (ad esempio "tb_1.dwg", "tb_2.dwg", ecc.).
Se la tavola DWG (ad esempio "plan_1.dwg") viene aperta in AutoCAD, i file DWG referenziati (ad esempio "tb_1.dwg", "tb_2.dwg", ecc.) vengono visualizzati come riferimenti esterni. 

2. Esplosione degli elementi: 
Gli elementi contenuti nei quadri vengono trasferiti in modo complesso. (ad esempio tratteggi, retini, linee di misura rimangono tali)
Gli elementi che sono direttamente nella tavola oppure nei quadri, in base all'impostazione nel campo Elementi da esploderepossono essere trasferiti in modo esploso oppure complesso.

3. Filtro elementi: 
Il filtro nel campo Elementi da trasferireha effetto sia per i dati che sono contenuti direttamente nella tavola che per quelli che sono nei quadri (se si esegue un trasferimento complesso). 

4. Costruzioni ausiliarie:
Per le costruzioni ausiliarie, il campo Elementi da trasferireconsente di filtrare sia nella tavola che nel quadro. A tal proposito, disattivare in Elementi da trasferirele opzioni Costruzione ausiliariaoppure Elementi non stampabili(stesso effetto).

5. Area di clipping:
Per area di clipping si intende un settore di taglio come ad esempio un passepartout finestra. Questi vengono analizzati in modo esatto. 

6. Struttura Allplan:
Per la tavola e per ogni quadro viene trasferito un DWG specifico e la struttura quadri. I layer dei quadri diventano layer DWG.

7. Spazio carta-modello: 
Questa variante di export trasferisce lo spazio costruzione (spazio modello) in ogni DWG.



Avviso: 

Se il proprio partner di progettazione non vuole più lavorare con più file DWG in AutoCAD, lui ha anche la possibilità di collegare i file DWG referenziati a quello della tavola e quindi utilizzare un singolo file.
Affinchè i dati dei file referenziati vengano visualizzati correttamente all'apertura del file DWG, è necessario che tutti i file creati vengano trasferiti e salvati nella stessa cartella.
Se si hanno ulteriori domande sullo scambio dei dati, consultare la documentazione disponibile nella . Guida in linea. La guida viene avviata con il tasto F1. Selezionare la scheda Indice -> Interfacce.
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			Domanda:

Allplan si avvia in modalità Viewer. Come posso risolvere il problema?



Risposta:

A tal proposito esegui i seguenti steps:

1.  Nella cartella del file licenza Allplan si trova il file servcfg.nse. 

Questa cartella può essere richiamata come segue: 
Allmenu -> Assistenza -> Windows Explorer -> Dati programma generali (ETC, LIC) -> License.

Se esiste, qui cancella il file servcfg.nse.

2. Ora carica una nuova licenza adeguata per il dongle collegato (il file licenza è allegato nell'appendice). Salva la licenza sul tuo computer e caricala come segue:
Allmenu -> Utility -> Licenza -> Carica licenza Hardlock

3. Se utilizzi un dongle USB (stick blu / bianco) e questo è collegato, la luce sul retro deve essere permanentemente accesa. Se non è così, a titolo di test, collega il dongle a un altra porta USB.

4. Se il dongle non emana luce, installa il driver hardlock aggiornato.
Istruzioni dettagliate in proposito sono qui contenute:

https://connect.allplan.com/it/faqid/20131028125253.html

5.  Passa quindi in Allmenu -> Utility -> Licenza -> Impostazioni licenza  ->  Licenze
Verificare se sulla finestra bianca di sinistra compare "Allplan FT". In caso affermativo, il dongle è stato riconosciuto correttamente. 

In caso negativo, salva i files logmes.nse, info.001e il nuovo servcfg.nseappena creato nella cartella delle licenze e inviali a support.it@allplan.com.
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			Domanda:

Come posso utilizzare Allplan e accedere da casa alla mia banca dati in ufficio (home-office) senza una connessione LAN diretta?



Risposta:

1.  Home-office con accesso simultaneo all'archivio dati centrale 


Allplan Share, la soluzione cloud di Allplan, consente a più utenti di accedere all'archivio dei propri progetti e lavorare tutti insieme pur non disponendo di una connessione LAN diretta. A tal proposito, sul computer di casa (home-office), Allplan deve essere installato in modalità stand-alone (programmi e dati). In altre parole, i dati (archivio file centrale) devono essere sul computer (e non in ufficio) altrimenti Allplan non può essere avviato. In presenza di un'installazione Workgroup, al fine di poter usare il  computer in questione senza una connessione LAN diretta, è necessario eseguire un suo check-out dal Workgroup e quindi di fatto un'installazione di tipo stand-alone. L'accesso ai dati funziona tramite il Cloud.  
In altre parole: il progetto deve essere nel cloud di Allplan (Allplan Share)

Il lavoro è semplice come quello su una normale installazione  stand-alone. Più utenti possono accedere e lavorare contemporaneamente nello stesso progetto. 

Per avere maggiori informazioni su Allplan Share accedi al link riportato di seguito oppure contatta il tuo partner commerciale:

https://www.allplan.com/it/add-ons/allplan-share/


Mediante il link riportato di seguito è possibile accedere ad ulteriori informazioni disponibili su Allplan Connect:


https://connect.allplan.com/it/forum/topics/topic/topics/redirect-forum=1.5.2/lavoro-home-office-1.html


Avviso: 

sconsigliamo l'utilizzo della VPN per accedere all'archivio comune dei progetti.
Allplan scambia una moltitudine di file con il server centrale. La crittografia dei file associata a una connessione Internet VPN comporta sensibili perdite di velocità e performance.
Perché sconsigliamo l'uso della VPN? Oscillazioni anche minime nella connessione via VPN potrebbero causare perdite di dati durante il loro trasferimento. In aggiunta, se non disponi di una connessione Internet sufficientemente veloce (almeno 100 Mbit up/down), il lavoro risulterà estremamente lento.
Tieni presente che Allplan non supporta la connessione VPN con protocollo IPv6 ma riconosce solo quella con IPv4. 
Devi inoltre accertarti che il collegamento VPN sia permanente e non passi in modalità di sospensione (stand-by). 

Per tutte queste ragioni, non possiamo fornire alcun supporto su questo tipo di configurazione. 



2. Home-office senza accesso all'archivio dati centrale (lavoro locale):



2.1 Allplan con Workgroup-manager:

Se disponi di una licenza Workgroup-manager, puoi effettuare il check-out (del tuo computer / laptop e dei relativi progetti) dall'ambiente Workgroup in ambiente Home-office (installazione stand-alone) e lavorare senza accesso al server. I progetti del computer "checked-out" risultano bloccati agli altri utenti CAD della rete. Questi utenti vedranno il commento indicato in fase di check-out.

Istruzioni dettagliate sono contenute qui:

https://connect.allplan.com/it/faqid/20160923105251.html

Se disponi di un License Server, scollega / prendi in prestito la licenza dal server delle licenze oppure collegati al License Server dell'ufficio mediante connessione VPN:

https://connect.allplan.com/it/faqid/20180109095437.html
https://connect.allplan.com/it/faqid/20160523165423.html




2.2 Allplan senza Workgroup-manager:

Utilizzo del computer dell'ufficio 
Se desideri usare il computer dell'ufficio (configurato per l'accesso alla rete e senza l'opzione Workgroup-manager) ma non puoi accedere alla rete dell'ufficio devi forzatamente disinstallare Allplan e re-installarlo in modalità stand-alone indicando delle cartelle locali. A questo punto potrai importare il backup dei progetti necessari nell'installazione locale. 

Utilizzo di un nuovo computer (privato) 
Se a casa desideri usare un nuovo computer, restituisci la licenza del computer in ufficio e quindi installala su quello nuovo (home-office). 


Evita di lavorare parallelamente nello stesso progetto su entrambi i computer (lavora su un computer o l'altro). La fusione dei dati di un progetto provenienti da due computer distinti potrebbe essere complicata.

Di seguito le istruzioni su come trasferire un progetto:

https://connect.allplan.com/it/faqid/20180507154505.html
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			Domanda:

Cosa devo fare se dopo l'upgrade, Allplan non parte più e viene visualizzato il messaggio:
Allplan
Stop
...

Successivamente appare un messaggio di errore del Quality Reporters.



Risposta:

Spegni Allplan su tutti i posti di lavoro ed esegui i seguenti steps:
Apri Allmenu e annota la cartella che segue "Archivio file centrali" (questa viene indicata nella finestra di Allmenu).
Verifica inoltre se nell'ultima riga dopo Workgroup-manager compare la registrazione "Sì" oppure "No".

Apri l'archivio file centrali mediante Windows-Explorer.

Se in Allmenu dietro a Workgroup-manager compare 
- "Sì", apri la sottocartella NET
- "No", apri la sottocartella PRJ

Cerca il file "Project.dat" nella cartella NET / PRJ e rinominalo in "Project-old.dat".

Esegui quindi i seguenti steps:
Allmenu -> Assistenza -> Strumenti hotline -> reorg -> OK -> Riorganizza file gestione progetti  -> OK
Il file di gestione dei progetti viene corretto e Allplan potrà essere nuovamente avviato.



Avviso:

se il file di protocollo non viene visualizzato oppure se per gli steps eseguiti non compaiono messaggi di errore, invia le informazioni di analisi riportate di seguito via e-mail a support.it@allplan.com:

	Una descrizione di cosa è stato eseguito appena prima dell'errore / del blocco.

	Il messaggio di errore esatto (possibilmente come screenshot).

	Il file di protocollo Stderr.out con il blocco protocollato.
https://connect.allplan.com/it/faqid/0001a27a.html

	Una richiesta di supporto (Hotinfo) con la domanda 01 selezionata. 
https://connect.allplan.com/it/faqid/20130823123806.html
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			Domanda:

Desideri installare Allplan e hai bisogno di un Product Key. Come è possibile installare Allplan oppure attivare il Product Key a posteriori? 


Risposta:

A partire dalla versione 2016, Allplan utilizza un nuovo sistema di protezione. La concessione licenza di Allplan ora è basata sul CodeMeter di Wibu Systems AG. Le tue concessioni licenza precedenti via Softlock, oppure via Hardlock non funzionano più con Allplan 2016/2017.
Allplan 2016/2017 ha bisogno di un Product Key con cui puoi attivare la tua licenza  online. Il Product Key è una stringa univoca di 26 caratteri che consente di attivare una licenza Allplan.
Il tuo Product Key è disponibile sul portale servizi Allplan Connect alla pagina http://connect.allplan.com/license
Una licenza può essere attivata già durante l'installazione di Allplan oppure, se Allplan è già stato installato, a posteriori. Dopo aver attivato la licenza, questa viene collegata al tuo computer e Allplan potrà essere avviato su questo computer.
L'attivazione della licenza avviene in modo più semplice e veloce se il computer dove deve essere attivata dispone di una connessione Internet.
Attivare la licenza durante l'installazione:
Avvia il setup e segui le istruzioni fornite dai dialoghi.
	Non appena appare la finestra dialogo d'installazione "Opzioni installazione", seleziona l'opzione Attivazione licenzae fai clic su Avanti.
	Immetti il tuo Product Key.
	Fai clic su Attiva licenza.



Attivare licenza a posteriori:

	Richiama la finestra dialogo "Impostazioni licenza" da Allmenu -> Utility -> Impostazioni licenza.
	Spostati sul lato sinistro e fai clic su Attivazione licenza.
	Immetti il tuo Product Key.
	Fai clic suAttiva licenza.



Avviso:

Il tuo Product Key è disponibile sul portale servizi Allplan Connect alla pagina http://connect.allplan.com/license
A tal proposito fai clic su Profilo -> Gestione licenze. 
Questa funzione può essere utilizzata esclusivamente come amministratore.


Istruzioni video step by step:
Al link riportato di seguito puoi vedere un video in cui viene illustrata la nuova concessione licenza Allplan 2016.https://connect.allplan.com/it/support/loesungen.html
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			Domanda

Hai attivato la licenza offline. Ora è disponibile un update, oppure desideri recuperare la licenza per la nuova versione 
e aggiornare i posti di lavoro Allplan. Come procedere in questo caso? 



Risposta

L’aggiornamento della licenza si effettua dal CodeMeter Control Center.

Per procedere, avvia il CodeMeter Control Center
aprendo il menu start di Windows e facendo clic su “CodeMeter” - “CodeMeter Control Center” oppure inserendo nella barra di ricerca di Windows CodeMeter. 

Sotto “Licenze” vengono visualizzati i numeri di container. Qui dovrebbe essere visualizzato anche il container della licenza. 
Nel caso di licenze per License Server, si tratta di un container Allplan CM6 con codice 130-XXXXXXX.


Avviso
Se è presente un solo container Allplan GmbH Container con codice 128-XXXXXXX, lo stato della licenza è obsoleto. Segui il punto 1 di questa istruzione: https://connect.allplan.com/it/faqid/20160527114300.html. 


Seleziona il container Allplan CM6 e fai clic a destra su Attivazione licenza. Nell’assistente seleziona il primo punto Crea richiesta di licenza. Crea così un file *.WibuCmRaC per il container. 

Con questo file accedi a un computer online.

Da lì apri la seguente pagina Web: 
http://lc.codemeter.com/59885/depot_159/index.php

Nella riga “Ticket” immetti il Product Keye fai clic su Avanti. Verrà visualizzata la licenza 
(ad esempio, anche la nuova licenza 2017 con lo stato disponibile). Fai clic su Attiva licenza.


Ora si vede il nuovo update licenza (spuntato). Fai clic in basso a destra suTrasferimento licenza offline.

Ora è possibile caricare il file *.WibuCmRaC (da “Sfoglia...”) e fare clic su Carica ora richiesta di licenza. Viene creata la licenza scaricabile con Scarica ora file di aggiornamento licenza.Questo file dev’essere quindi installato sul server.

A tal fine, in CodeMeter Control Centerbasta fare clic su File -> Importalicenzaper installare la licenza. 
La licenza aggiornata dovrebbe essere visualizzata nelle License settings.



Per terminare, carica la ricevuta.
Per procedere, torna al Control Center CodeMetere in “Licenza” seleziona il nuovo prodotto Allplan CM6 con il codice 130-XXXXXXX.

Quindi fai clic su Aggiornamento licenza -> Avanti -> Crea ricevuta. 
Crea il file ricevuta da questo container. 

Torna con questo file a un computer online.

Carica quindi il file ricevuta anche dalla pagina Web. 
Nella pagina Web, qui fai clic su Avanti
Se la pagina Web è già stata chiusa, riapri il link sopra riportato e immetti di nuovo il Product Key. Seleziona quindiContinua trasferimento licenza. 
Cerca il file ricevuta, selezionalo e fai clic suCarica ora ricevuta
Premendo OKsi chiude l’attivazione.


Se hai varie licenze per License Server, è possibile che siano contenute tutte nello stesso container Allplan CM6 ma per aggiornarle tutte è necessario eseguire i passi Carica file di aggiornamento licenzae Carica ora ricevutaper ogni Product Key o licenza.



Avvisi
	Al momento non è possibile aggiornare le licenze da Allplan Connect. Da Allplan Connect è solo possibile eseguire la prima attivazione offline o la restituzione di una licenza. 

	Sapevi che puoi visualizzare i dettagli relativi alle licenze (ad esempio in quale container e su quale computer sono archiviate) anche dal Service portal Allplan Connect in http://connect.allplan.com/license? Devi semplicemente caricare i dettagli della licenza relativi alle licenze visualizzate premendo sul pulsante Informazione alla fine della riga corrispondente.
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			Domanda:

Ho eseguito il check-out dalla rete sul mio computer con la funzione "Check-out/-in" e ho tolto la connessione di rete. 
Perché ora il mio workgroup-manager non funziona più?



Risposta:

Windows ha disattivato le funzionalità di rete poiché è stata tolta la connessione di rete (il cavo di rete).
L'avvio di Allplan richiede tuttavia determinati protocolli di rete (anche se è stato eseguito il check-out).



Soluzione: 

Per mantenere le funzionalità di rete del sistema operativo è possibile installare una scheda di rete virtuale. 
A tale scopo, Microsoft mette a disposizione un driver (Loopback adapter).

Procedura d'installazione:

Windows 8/10:
Fai un clic destro del mouse su Start -> Esegui
Immetti "hdwwiz" nel campo di ricerca. Fai un clic destro del mouse sul programma trovato e quindi su "Esegui come amministratore".
Avanti -> Installa hardware selezionato manualmente da un elenco -> Avanti
Seleziona "Scheda di rete" nell'elenco -> Avanti
Spostati sul lato sinistro, seleziona "Microsoft", spostati sul lato destro e seleziona "Microsoft Loopback adapter per KM-TEST" -> Avanti -> Avanti

Windows 7:
Start -> immetti "hdwwiz" nel campo di ricerca. Fai un clic destro del mouse sul programma trovato e quindi su "Esegui come amministratore".
Avanti -> Installa hardware selezionato manualmente da un elenco -> Avanti
Seleziona "Scheda di rete" nell'elenco -> Avanti
Spostati sul lato sinistro, seleziona "Microsoft", spostati sul lato destro e seleziona "Microsoft Loopback adapter" -> Avanti -> Avanti

Windows Vista:
Avvia "Hardware Wizard" da 
Start -> Pannello controllo -> Hardware e vai su Procedi -> Avanti
Nel successivo campo di selezione, evidenzia "Installa hardware selezionato manualmente da un elenco (per utenti esperti)" e seleziona nell'elenco seguente "Scheda di rete".
Questo attiva e installa l'adattare di rete "Microsoft Loopback adapter".
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			Domanda

Hai installato un Windows Update e la licenza non è più disponibile?
Avvii Allplan e all’improvviso ti appare il messaggio “La licenza non è più disponibile” oppure “CmActLicense runtime system is not installed!”. Come posso ripristinare la licenza?



Risposta

La licenza viene sempre archiviata sul tuo computer nel CodeMeter Control Centerin un container con il numero Allplan GmbH 128-XXXXXXX. 

Avvia il CodeMeter Control Center 
aprendo il menu start di Windows da CodeMeter -> CodeMeter Control Center. Oppure nella barra di ricerca della pagina di start immetti Codemeter. 
InLicenze, i numeri di container visualizzati, controllare se viene visualizzato un container Allplan GmbH 128-XXXXXXX .
Il container deve essere rappresentato da un’icona di colore verde-azzurro [image: ]
, non rosso [image: ]



Verifica se sono utili i seguenti step:

Step 1 Riavviail servizioCodeMeter
Il servizio Windows locale utilizzato per la concessione della licenza deve essere attivo. 

Riavvia quindi il servizio:
CodeMeter Control Center -> Processo -> Avvia il servizio CodeMeter
Se il servizio risulta avviato, stoppalo e quindi riavvialo. 

Controlla ora se viene visualizzato il container Allplan GmbH 128-XXXXXXX.

Se il riavvio del servizio è risultato utile, chiudi CodeMeter dallo scanner antivirus seguendo le istruzioni in: https://connect.allplan.com/en/faqid/20151209133620.html

Se il container continua a non essere visualizzato, passa allo step 2.


Step 2 Aggiornare il programma CodeMeter
La versione aggiornata di “Codemeter Control Center” può essere scaricata dal nostro server FTP.

Immetti il seguente indirizzo in Windows Explorer (non in Internet Explorer!):
ftp://hotadmin@ftp.entw.nemetschek.de/download/Allgemein/Wibu/CodeMeterRuntime.exeftp://nemhotline:ha37jvg8f@ftp.nemetschek.de/download/Allgemein/Wibu/CodeMeterRuntime.exe

In alternativa puoi anche scaricare il programma di installazione (CodeMeter User Runtime per Windows) direttamente dal produttore https://www.wibu.com/de/anwendersoftware.html

Avvia il file “CodemeterRuntime.exe” dalla gestione dell’account utente. 
Attiva il file per l’installazione facendo clic con il tasto destro del mouse nel menu contestuale 
“Esegui come amministratore”.
Nel setup conferma tutti i messaggi e le preferenze definite con “Avanti”.
CodeMeter Control Center viene infine installato.

Controlla ora se viene visualizzato il container Allplan GmbH 128-XXXXXXX.

Quando il container viene visualizzato con un’icona di colore verde-azzurra, aprire le impostazioni licenza.

Allmenu -> Utility -> Impostazioni licenza -> Selezione licenza
Qui dovrebbero apparire le licenze. Spuntare esplicitamente le licenze nella selezione licenze. Ora prova a riavviare Allplan. 


Step 3 Contattare il supporto
Invia a support.de@allplan.com le seguenti informazioni da analizzare:
Se il container non viene visualizzato o se appare ancora con un’icona di colore rosso, inviaci uno screenshot del CodeMeter Control Center-> Licenze indicando il numero di licenza e del posto di lavoro o il Product Key utilizzato.
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			 Compito: 

Si desidera esportare il modello animato 3D e farlo vedere a qualcuno che non dispone di Allplan.



 Preparazione:

Installare sul posto lavoro dove si desidera visualizzare i dati 3D un plug-in corrispondente per Internet Explorer che consenta di aprire i file VRML.

 Un simile plug-in è messo a disposizione ad ad esempio da Parallelgraphics
Questo è disponibile per i seguenti browser:
Internet Explorer 6.0, Netscape Browser 8.0 , Mozilla Firefox 1.5 , Opera 8.5 e relative versioni aggiornate.

 http://www.cortona3d.com/Products/Cortona-3D-Viewer.aspx 



 Soluzione:

Richiamare la finestra di animazione di Allplan.
Selezionare File -> Esporta -> Esporta dati Cinema 4D/VRML/3DS/U3D... e salvare i dati con un qualsiasi nome in Explorer. 
Si consiglia di salvare il file in una cartella vuota poichè insieme al file VRML vengono salvate nella cartella anche tutte le texture utilizzate in Allplan. 
Facendo doppio clic sul file VRML i dati vengono visualizzati in Internet Explorer. In modo analogo alla finestra di animazione di Allplan, qui sono disponibili diverse funzioni di movimento e zoom.



 Avviso:

A partire dalla versione 2008, nel menu contestuale della finestra di animazione è anche disponibile la funzione Esporta PDF 3D. Il file PDF così generato può essere visionato con Adobe Reader a partire dalla versione 2008.
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			Domanda:

Dopo avere eseguito l'update da Windows 8 alla versione 8.1, oppure dalla 8.1 alla 10 oppure un Windows Update all'interno di Windows 10, Allplan viene avviato solo come Viewer. Come posso rimediare?


Risposta:

Il Windows Update danneggia la gestione licenze Nemetschek Softlock. 
Ripara la gestione licenze Nemetschek Softlock come segue:

La gestione licenze Softlock corrente è disponibile come download al seguente indirizzo FTP:

ftp://nemhotline:ha37jvg8f@ftp.nemetschek.de/download/Allplan/2015/NemSLock/

Esegui il download del file Nemetschek_Software_Lock.exe. 

Esegui il file "Nemetschek Software Lock.exe"e seleziona "Ripara programma"

Al termine dell'installazione, la gestione licenze può essere nuovamente aperta (Allmenu -> Utility -> Licenza -> Gestione licenze). Ora carica il tuo file di licenza provvisorio (*_psd.nslock) da "Carica - Carica licenza".

All'occorrenza questo può essere scaricato dal tuo profilo di Allplan Connect:
https://connect.allplan.com

Avviso: la licenza temporanea verrà mostrata con lo status "Scaduto"

Crea quindi una nuova richiesta di registrazione. 
Una richiesta di registrazione avviene come segue:

Apri la gestione licenze (Allmenu -> Utility -> Licenza-> Gestione licenze). Evidenzia la licenza del tuo posto lavoro e fai clic su "Richiedi licenza". 
Sarai guidato attraverso il menu di registrazione. Compila il modulo prestando particolare attenzione al tuo indirizzo e-mail. 

Verifica che nella registrazione i tuoi codici Client ID e CD Key siano stati indicati correttamente e, se necessario, correggili.

Invia la tua richiesta di registrazione a: register@nemetschek.de
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			Domanda:

Dispongo di più licenze e desidero avviare Allplan con una licenza specifica. Come posso fare? 



Risposta:

Apri le impostazioni licenza sul Client

Allmenu -> Utility -> Impostazioni licenza -> Selezione licenza

Qui vengono mostrate tutte le licenze disponibili in rete. L'utilizzo di queste licenze può essere influenzato come segue.


Eseguendo una selezione diretta della licenza (voce spuntata) è possibile evidenziare una oppure più licenze come preferito. Successivamente queste licenze verranno impiegate in via preferenziale. L'icona [image: ]
consente di evidenziare le licenze che non si vogliono utilizzare.

Attiva oppure disattiva le priorità relative alle tue licenze. 

Se non è stata eseguita alcuna impostazione oppure sono state evidenziate come preferito più licenze, Allplan utilizzerà automaticamente la prima licenza libera trovata.


Avviso:

presta attenzione alla disponibilità delle licenze.
Colonna "Disponibile": 
qui vengono mostrate le licenze che sono ancora disponibili e, quindi, 3/5 significa che 3 licenze su un totale di 5 sono ancora libere. Facendo clic sulla freccia rivolta verso il basso è possibile visualizzare la licenza correntemente in uso da parte di un utente.
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			Domanda:

Come posso caricare file DXF oppure DWG con coordinate elevate?



Risposta:

Se il file DXF oppure DWG contiene elementi su coordinate elevate (ad esempio dati di rilievo catastale in coordinate Gauß-Krüger), dopo l'importazione in Allplan questo potrebbe influire sulle performance del programma. Per eseguire un import dei dati senza problemi procedere come descritto di seguito.
Possibilità 1: Impostare l'offset
Impostare un offset nel progetto. A partire da Allplan 2011 questo può essere definito già in fase di creazione di un nuovo progetto.  Per i progetti esistenti, l'impostazione può essere effettuata a posteriori da File ->Apri progetto-> evidenziare il progetto -> menu contestuale Proprietà. (fino alla versione Allplan 2009 questo avveniva da Strumenti -> Opzioni -> Costruzioni avanzate -> scheda 'Impostazioni'). Al punto 2 è descritta una procedura per impostare automaticamente l'offset in fase di importazione.
Possibilità 2: Adatta baricentro a: Offset 
Durante l'importazione, entrare nelle 'Opzioni' -> scheda 'Impostazioni generali' (fino alla V2008 'Impostazioni trasferimento avanzate') e attivare la casella di controllo Adatta baricentro a "Offset". In questo modo nel progetto viene impostato automaticamente un offset, che posiziona il baricentro del file (=punto centrale del Min-Max-Box) sul punto 0,0,0 del sistema di coordinate. Questa opzione non è disponibile se è già impostato un offset oppure se nel file da importare non ci sono dati con coordinate elevate.
Possibilità 3: Adatta baricentro a: 0,0,0
Durante l'importazione, entrare nelle 'Opzioni' -> scheda 'Impostazioni generali' (fino alla V2008 'Impostazioni trasferimento avanzate') e attivare la casella di controllo Adatta baricentro a "0,0,0". In questo modo il baricentro del file viene spostato sullo zero assoluto (0,0,0) del sistema di coordinate di Allplan. Al contrario dell'opzione precedente, vengono modificate anche le coordinate. Utilizzare pertanto questa possibilità solo se questo file viene utilizzato all'interno dell'ufficio e non deve essere nuovamente esportato nella stessa posizione (e quindi non ci sono vicoli rispetto alle coordinate territoriali).
Possibilità 4: Adatta baricentro a: Off
In questo caso i dati vengono importati in Allplan senza considerare le coordinate. Per lavorare su coordinate elevate è anche possibile impostare un apposita impostazione in: Opzioni -> Ambiente lavoro ->  Ottimizza lavoro con coordinate alte( fino ad Allplan 2009: Strumenti -> Opzioni -> Opzioni generali -> scheda 'Altro' -> Ottimizza lavoro con coordinate alte). Questa impostazione influisce positivamente su questa problematica. In linea generale più i dati sono distanti dal sistema di origine (0,0,0), maggiori possono essere gli effetti sulle performance. Come ulteriore possibilità, è possibile spostare i dati in Allplan con la funzione 'Sposta' vicino al sistema di coordinate 0,0,0 e all'occorrenza impostare un offset corrispondente al vettore di spostamento selezionato.



Avviso: 
L'utilizzo di un offset (con entrambe le procedure precedenti) è nella maggior parte dei casi la soluzione migliore. Modificare i dati nelle coordinate originali utilizzando delle coordinate che considerano l'offset impostato e che quindi vengono misurate correttamente. L'offset impostato viene considerato automaticamente in fase di esportazione e importazione. Questo vale per l'intero progetto. 
Se i dati non devono essere ri-esportati nella stessa posizione, è consigliabile utilizzare la terza possibilità -> Adatta baricentro a: 0,0,0
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			Domanda:

Come posso aggiornare il mio License Server e/o le mie licenze? 



Risposta:

Durante l'utilizzo di Allplan 2016:  Prima di eseguire questi steps, accertati che la versione 2016-1-4 oppure successive sia stata installata su tutti i clients.  
Durante l'utilizzo / l'upgrade di Allplan 2017 Verifica la versione del License Server come descritto di seguito e aggiorna le tue licenze. 

1. Aggiornare il License Server 
Verifica quale versione di License Server hai installato. A partire dalla versione License Server 2016-1-4 le informazioni dettagliate sulla versione (Build-ID) vengono mostrate direttamente nel programma License Settings(in basso a sinistra).
Qui deve essere visualizzata almeno la versione 1.614.x.x. Se non è visualizzato alcun Build ID significa che stai ancora utilizzando un vecchio License Server. 
In questo caso aggiorna il tuo License Server. A tal proposito scarica il software del License Server dal portale di servizi Allplan Connect oppure dal nostro server FTP:

ftp://nemhotline:ha37jvg8f@ftp.nemetschek.de/download/Allplan/Lizenzserver/2016/DoWn-2016-License_Server_Setup.zip

Avvia il nuovo License Server Setupsul computer / sul server che deve essere utilizzato come License Server. Evidenzia il file *.exe, apri il menu contestuale e seleziona -> Esegui come amministratore.
	Fai clic su Install.
	Fai clic su Exit. 


Se fino ad ora non è mai stato installato il License Server (oppure stai passando solo ora ad Allplan 2016/2017), le istruzioni complete sono disponibili al link riportato di seguito.
https://connect.allplan.com/it/faqid/20150618084450.html


2. Aggiornare le licenze
Aggiorna le tue licenze sul License Server:

	Passa al server e avvia il programma License Settings.
	Passa al lato sinistro, fai clic su Attivazione licenzae quindi sulla licenza che desideri aggiornare (in modo tale che appaia evidenziata in blu).
	Ora la funzione "Aggiorna licenze" dovrebbe essere attiva nel tuo programma.
	Fai clic su Aggiorna licenza.
	Se la tua licenza è composta da più configurazioni per ogni posto lavoro, devi aggiornare ogni licenza / posto lavoro.
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			Domanda

Non è possibile rieseguire il check-in o il check-out del computer.
Al check-in, appare il messaggio d’errore “Le voci del registry non sono corrette!”. Come posso risolvere questo problema?


Risposta

Sul server è presente un file nascosto che non è stato possibile cancellare. Potrebbe dipendere dai diritti utente o dalla gestione dell'account utente. 

È necessario modificare le impostazioni direttamente sul server, ovvero nelle opzioni della cartella visualizzare tutte le cartelle e i file nascosti. 

1. Sul server, accedi alla directory della cartella archivio file centrale, che nella cartella subordinata 
NET contiene il file Nome_computer.out. (in questo caso, Nome_computer è il nome del computer checked-out).
Cancella il file.

2. Nella cartella di condivisione locale sul laptop (ad esempio C:\DatiNem\Allplan)
Fino ad Allplan 2015: cancella la cartella Net.ChkOut
A partire da Allplan 2016: cancella la cartella NET

Il check-in del laptop è stato eseguito e ora dovrebbe essere di nuovo possibile spostare i progetti ed 
eseguire il check out. 


Avviso

Se il computer o i progetti continuano ad apparire in "rosso", è necessario ripararli.

Per riparare i progetti procedi nel seguente modo:
Allmenu -> Workgroup-manager -> Gestisci computer e progetti.

Se il computer o i progetti appaiono in rosso, per eseguire la riparazione procedi nel seguente modo:

Ctrl + tasto destro del mouse su Computer-> è possibile eseguire il check-in
Ctrl + tasto destro del mouse su Progetto -> è possibile eseguire lo sblocco

In questo modo si sblocca ogni progetto sul laptop.
Chiudi e riapri quindi la maschera “Gestisci computer e progetti” perché non si aggiorna molto rapidamente.
Ora dovrebbe essere tutto correttamente registrato (check in) e l'accesso di nuovo disponibile.
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			Domanda:

Allplan crea files di backup (*.bak)?
Come possono essere utilizzati?



Risposta:

Allplan crea dei files di backup solo eseguendo i seguenti comandi:

	Copia, sposta fra documenti...
Viene creato un file di backup del quadro di destinazione / della tavola di destinazione
	
	Cancellazione dei quadri e delle tavolenella finestra "Apri documenti progetto"
Se è stata selezionata l'opzione "Copia backup dei quadri - crea", viene creato un file di backup del quadro / della tavola.
	
	Durante l'import dei dati nei quadri
Se è stata selezionata l'opzione "Copia backup dei quadri - crea", viene creato un file di backup del quadro.


Avvisi per il punto 2. e 3.: 

l'opzione "Copia backup dei quadri - crea" viene attivata da:
Strumenti -> Opzioni -> Ambiente lavoro -> sezione Salva/carica (fino alla V2009 "Opzioni generali" -> "Varie" -> "Salvataggio/backup automatico")->Copia backup dei quadri - crea


Ripristino:

all'occorrenza è possibile ripristinare il quadro oppure la tavola originale.
Annota il numero del quadro / della tavola e identifica la cartella del progetto corrispondente:
Allmenu -> Assistenza -> Strumenti hotline -> wopro

Apri la cartella identificata in Windows Explorer.

Rinomina il quadro corrispondente (ad esempio "tb000001.ndw" in "tb000001.ndw.old") oppure la tavola corrispondente ("pb000001.000" in "pb000001.000.old").
Ora togli l'estensione "bak" dal file corrispondente.

Esempio 1: 

sul quadro 4711 sono stati copiati per errore dei dati sbagliati:
1. abbandona il progetto Allplan
2. cancella il file tb004711.ndw oppure rinominalo, ad esempio, in tb004711.ndw.old
3. rinomina il file tb004711.ndw.bak in tb004711.ndw

Esempio 2: 

sulla tavola 815 sono stati copiati per errore dei dati sbagliati:
1. abbandona il progetto Allplan
2. cancella il file pb000815.000 oppure rinominalo, ad esempio, in pb000815.000.old
3. rinomina il file pb000815.000.bak in pb000815.000



Avviso:

considera che i files di backup possono aumentare sensibilmente la quantità di dati dei progetti. Pertanto, prima di procedere all'archiviazione, valuta la possibilità di cancellare i files .bak che non sono più necessari. I file .bak possono essere cancellati, ad esempio, da Allmenu con Utility -> Cancella file temporanei.

Queste istruzioni sono contenute anche nell'help online di Allplan al paragrafo "Utilizzo dei files .bak".
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			Domanda

Come posso "automatizzare" l'installazione di Allplan?


Risposta

L'installazione di Allplan 2017 può essere eseguita in Silent Mode. Con questa modalità l'installazione è completamente automatica e non necessita di immissioni da parte dell'utente. Questa procedura d'installazione è consigliata se i posti lavoro Allplan 2017 devono essere installati in rete con le stesse impostazioni.
Per poter installare in Silent Mode devono essere soddisfatti i seguenti requisiti:
Tieni sempre in considerazione i diversi tipi di concessione di licenza!
Concessione di licenza per posto singolo
Sul computer su cui desideri registrare l'installazione Silent non dev’essere stata ancora attivata alcuna licenza attiva. Per la registrazione dev’essere utilizzata l’opzioneViewer. 

Dopo aver eseguito l’installazione Silent su tutti i computer, è necessario attivarla in locale su ogni singolo computer utilizzando il Product Key. 
Attivazione della licenza a posteriori
	Richiama la finestra dialogo “Impostazioni licenza” da Allmenu -> Utility -> Impostazioni licenza.
	Fai clic su Attivazione licenza.
	Immetti il Product Key.
	Fai clic suAttiva licenza.



Se si utilizza un License Server:
	La concessione licenza dei clients avviene mediante un License Server.
	Il License Server è stato installato.
	La licenza del License Server è stata attivata.

Ulteriori informazioni sul License Server si trovano anche qui: http://connect.allplan.com/de/support/loesungen.html?tx_nemsolution_pi1%5BdokID%5D=20161115093205.htmlhttps://connect.allplan.com/it/faqid/20150618084450.html
Alla registrazione, seleziona l’opzione Utilizza licenza attiva.

Le impostazioni per la licenza vengono protocollate nel file %AppData%\Nemetschek\Lic3.ini.I dati devono essere distribuiti a tutti i computer, nell'ubicazione corrispondente.


Ulteriori suggerimenti e avvisi
	Un package d'installazione di Allplan dovrebbe essere decompresso (ad esempio mediante 7-Zip ) in una cartella accessibile senza limiti da tutti i clients su cui deve essere installato.
	Esegui sempre come amministratore locale il prompt dei comandi nel quale viene avviato il setup del programma (menu contestuale > "Esegui come amministratore”). Nel prompt dei comandi, verifica sempre di essere nella cartella corretta prima di eseguire il comando.
	All'occorrenza, i componenti Microsoft necessari ad Allplan come Microsoft.NET Framework o Microsoft Report Viewer, vengono installati contemporaneamente senza che venga visualizzata una richiesta di conferma (modalità Silent).




Silent Installation vorbereiten

Per la registrazione e il caricamento dell'installazione Silent sono necessari i file d'installazione di Allplan 2017.
L'installazione in Silent Mode si svolge in tre step:
Protokolldatei für die Installation im Silent Modus erzeugen
Nel primo step viene eseguita l'installazione modello di un tipico posto lavoro Allplan 2017 con l'opzione /r. Le immissioni effettuate durante questa installazione vengono automaticamente protocollate nel file setup.iss che successivamente verrà impiegato per le installazioni degli altri posti lavoro.
Installationen im Silent Modus durchführen
Nel secondo step vengono installati tutti gli altri posti di lavoro Allplan 2017 con l'opzione /s che utilizza il modello d'installazione contenuto nel file di protocollo setup.iss.
Erfolg der Installationen im Silent Modus überprüfen
Nel terzo step si dovrebbe verificare se l'installazione in Silent Mode è avvenuta correttamente verificando il file setup.log generato automaticamente.
Avviso Di norma l'installazione in Silent Mode si esegue in tutti i posti di lavoro con un file setup.iss identico ma in certa misura è anche possibile editare il file setup.iss e personalizzare alcuni path. Per ulteriori informazioni consultare l’help online in Anpassen der Datei setup.isshttp://help.allplan.com/Allplan/2017-0/1031/Allplan/index.htm#331.htm


Allplan può essere installato con la modalità "Silent" descritta di seguito.

Installazione di .NET 4.6
Per eseguire il setup in modalità Silent è necessario avere preinstallato .NET 4.6. L'installazione del .NET 4.6 richiede infatti il riavvio del computer che disturba la procedura d'installazione Silent.


Se si è scaricato Allplan 2017, i file d’installazione sono impaccati ed è necessario decomprimerli prima di poter eseguire l'installazione Silent:
	Decomprimi innanzitutto il file zip scaricato per ottenere un file .exe (ad esempio Allplan 2017-0-5-cad.exe).
	Decomprimi quindi questo file .exe in una cartella a scelta utilizzando un apposito programma (ad esempio 7-Zip). Da lì ora puoi avviare il file Setup.exe per la registrazione dal prompt dei comandi.



1. Installazione modello
Innanzitutto viene creato un file di registrazione per mezzo di una “installazione modello”.

Avvia questa installazione dal prompt dei comandi con l'opzione "/r" (record):

Avvia il setup di <Product> come amministratore dal prompt dei comandi eseguendo la seguente immissione: 
setup.exe /r 

Il setup si avvia normalmente e si esegue con le indicazioni e le immissioni desiderate.

Licenza per posto lavoro singolo
Nella configurazione della licenza seleziona l'opzione Utilizza Viewer.
Con il License Server:
Nella configurazione licenza seleziona l'opzione Utilizza licenza attiva.


L'installazione viene protocollata nel file di registrazione setup.iss.

È possibile influire anche sulla cartella e il nome del file di registrazione:

setup.exe /r /f1<nome cartella>:\Setup.iss
ad esempio
setup.exe /r /f1c:\Setup.iss
In questo caso il file viene salvato direttamente in C:\ .

Attenzione: 
Fra "f1" e la cartella non ci devo essere spazi vuoti!

Copiare il file setup.iss in una cartella accessibile da ogni posto di lavoro. La cosa più semplice è copiare il file nella cartella con i file d'installazione di Allplan. 

Con il License Server:
Copia il file %AppData%\Nemetschek\Lic3.inisu ogni computer client nella cartella %AppData%\Nemetschek.
Se non hai ancora lavorato con Allplan sul computer client, nella cartella "%AppData%" deve essere innanzitutto creata la cartella Nemetschek. (ad esempio: C:\Utenti\Nome utente\Appdata\Roaming\Nemetschek) 


2. Installazione Silent:
Verifica che il file setup.iss sia accessibile.

Con il License Server:
Controlla che nella cartella %AppData%\Nemetschek\ il file Lic3.ini sia disponibile.


La procedura di installazione viene registrata nel file setup.log nella stessa cartella del file setup.iss. L’opzione /f2 consente di indicare una cartella e un nome di file diversi per setup.log.

L'installazione Silent sul computer client si richiama utilizzando il seguente comando nel prompt dei comandi:

setup.exe /s /f1<Indicazione_cartella>:\Setup.iss /f2<Indicazione_cartella>:\Setup.log

ad esempio
setup.exe /s /f1c:\Setup.iss /f2c:\Setup.log
In questo caso il file viene salvato direttamente in C:\ .

Verifica che l’installazione nel file setup.log sia stata eseguita correttamente. La procedura è andata a buon fine se nella sezione [ResponseResult] il valore restituito è ResultCode=0.



Avviso 

se hai varie licenze o License Server, seleziona la licenza desiderata sui computer client da Allmenu - Utility - Impostazioni licenza.

Informazioni dettagliate sull'installazione Silent sono contenute nell'help online (tasto F1) del setup. 
http://help.allplan.com/Allplan/2017-0/1031/Allplan/index.htm#321.htm
Apri l'help (tasto F1) passa alla scheda "Contenuto" -> "Eseguire installazione -> Installazione in Silent Mode"

Oppure nell'help dell'impostazione licenza
Allmenu -> Utility -> Impostazione licenza 
Apri l'help (tasto F1), vai alla scheda "Contenuto" -> "Validare licenza Allplan mediante un License Server" -> "Installazione in Silent Mode".


Considera che non possiamo fornire supporto individuale su questa procedura.
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			Compito: 

Allplan è stato installato su più posti lavoro locali e ora si desidera cambiare il tipo d'installazione per poter accedere a un'unità di rete condivisa.



Nota: 

Per passare da un'installazione stand-alone a una di rete è indispensabile eseguire un backup completo dei dati su tutti i posti di lavoro. 
Si consiglia di eseguire questa operazione con il supporto di uno dei nostri tecnici!



Istruzioni: 

Di seguito sono riportate le istruzioni per convertire più posti di lavoro singoli locali (con differenti banche dati dei progetti) in posti di lavoro Allplan con driver di rete comune senza workgroupmanager.

1. Preparativi
Individuare un posto lavoro su cui caricare tutti i progetti e gli standard dell'ufficio. Successivamente, questo sarà indicato come il posto di lavoro principale. 
Nel primo step tutti i progetti vengono raggruppati sul posto lavoro principale.

1.a Copiare le risorse nel progetto
Per evitare problemi legati alle differenze dello standard ufficio, le risorse utilizzate dai progetti vengono innanzitutto copiate nelle rispettive cartelle del progetto.
A tal proposito eseguire la seguente impostazione per ogni progetto:
Allplan -> File -> ProjectPilot / Gestione dati -> selezionare il singolo progetto -> tasto destro mouse -> Proprietà -> scheda Impostazioni
Cambiare le impostazioni del path da 'Ufficio' a 'Progetto' per: 'Definizioni penna e riga', 'Tipi carattere', 'Retini, tratteggi, stili area', 'Catalogo sezioni As tondini e reti', 'Strutture layer, stili linea, tipi disegno' e 'Proposta attributi'.
Gli elementi corrispondenti vengono copiati dallo standard ufficio nel progetto e quindi si ha la garanzia che le impostazioni del progetto rimangono uguali anche se vengono copiati su un nuovo server con un nuovo standard ufficio.

1.b Nome cartella = nome progetto
Se si desidera raggruppare i progetti come al punto 2.b, selezionare l'impostazione 'Nome cartella = nome progetto' nella scheda 'Generale'.

1.c Colore penna (colore indica penna)
Il colore penna per l'impostazione 'Colore indica penna' non viene salvata nel progetto ma nella cartella specifica dell'utente (...\Usr).

2.a Salvare i progetti dei posti lavoro secondari e caricarli sul posto lavoro principale (metodo consigliato)
I singoli progetti dei posti lavoro secondari vengono salvati da Allmenu con  Salvataggio dati -> Scambio dati -> Salva progetto con nome. 
È possibile salvare più progetti in un passaggio unico.
A tal proposito, procedere con Allmenu -> Configurazione -> Path salvataggio -> Cerca cartellae selezionare una cartella sul disco fisso locale oppure nella rete.

Passare quindi al posto lavoro principale e procedere al caricamento dei progetti da Allmenu -> Salvataggio dati -> Carica salvataggio -> Progetto con nome. I singoli progetti possono essere predisposti nella gestione dati del posto lavoro principale di Allplan oppure creati durante la fase di caricamento.

2.b. Salvare e i progetti dei posti lavoro secondari e caricarli su quello principale (soluzione speciale)
Questa soluzione speciale dovrebbe essere utilizzata solo in casi eccezionali da utenti Windows esperti. 
I progetti vengono caricati sul posto di lavoro principale con Windows Explorer:
Se ci sono nomi progetti doppi è necessario rinominarli prima del backup.

Sul posto lavoro principale è ora necessario rinominare il file project.dat esistente nella cartella Prj.
Ora selezionare Allmenu -> Assistenza -> Strumenti hotline -> reorg -> Ricrea file gestione progetti
Ora è stato creato un nuovo file di gestione progetti (project.dat) contenete tutti i progetti con il relativo nome.

Ora sul posto lavoro principale sono presenti tutti i progetti attualmente disponibili nell'ufficio.

3. Raggruppare gli standard dei progetti
A tal proposito copiare gli elementi da rilevare (simboli, macro, liste, ecc.) nel path esterno dal ProjectPilot dai posti lavoro secondari in modo tale da poterli riutilizzare nella cartella di rete impostata.
Nel secondo step, copiare gli elementi contenuti nel path esterno nello standard ufficio del posto lavoro principale mediante il ProjectPilot.

4. Backup dati
	Salvare ora i progetti, lo standard ufficio e le impostazioni utente del posto lavoro principale:
Questo può avvenire anche copiando i dati contenuti nei path ..\prj (progetti), ..\std (standard ufficio) e ..\usr (cartella utente) in una cartella di backup (ad esempio 'nembak') del disco fisso.
	Salvare inoltre la cartella ..\usr\local di ogni singolo computer.
	Esportare le impostazioni dell'interfaccia grafica di ogni utente in un file: Allplan -> Strumenti -> Personalizza... -> Esporta...


5. Disinstallazione
Disinstallare ora Allplan su tutti i posti di lavoro.

6. Nuova installazione
Prima di eseguire la nuova installazione della stessa versione, creare sul futuro server dati una cartella (ad esempio datiNem) e condividerla. In questa cartella viene creata una sottocartella Allplan.

Ora eseguire una nuova installazione (della stessa versione) su tutti i posti di lavoro.

Durante il setup indicare i seguenti path d'installazione:
Cartella programma:    
locale (ad esempio C:\Program Files\Nemetschek\Allplan)
Cartella archivio file centrali: 
Selezionare 'Sfoglia -> Rete...'
Cercare la cartella condivisa datiNem e selezionare la cartella Allplan . 

Procedere quindi all'installazione.

7. Avvio di prova e ripristino backup
Al termine dell'installazione (verificare almeno una volta l'avvio di Allplan) le cartelle salvate sul posto di lavoro principale (..\prj e ..\std) vengono copiate nella cartella del nuovo server ...\datiNem\Allplan. 

Copiare quindi da Explorer il contenuto della precedente cartella utente locale (…\usr\local) del computer stand-alone nella nuova cartella appena installata sul computer.

8. Aggiornare file gestione progetti
Rinominare il file project.datnella cartella server...\datiNem\Allplan\Prj inproject.old . Eseguire quindi i seguenti passaggi:
Allmenu -> Assistenza -> Strumenti hotline -> reorg -> Ricrea file gestione progetti 

9. Riassunto
Ora tutti i posti lavoro accedono alla stessa cartella di rete con lo stesso pool di progetti e standard ufficio.
Con questo tipo d'installazione, se un utente apre un progetto, gli altri utenti non ci possono accedere. Per consentire a più utenti di accedere contemporaneamente a un progetto è necessario eseguire un'installazione di Allplan con workgroupmanager.
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			Domanda

Vorresti sapere quale collega ha preso in prestito una licenza dal License Server e per 
quanto tempo?


Risposta

Premessa 
Verifica innanzitutto che sul License Server sia installata la versione CodeMeter 6.50.
A tal fine, sul server avvia il CodeMeter Control Center
aprendo il menu start di Windows da CodeMeter -> CodeMeter Control Center oppure nella barra di ricerca della pagina di start immetti Codemeter e premi INVIO. In Help -> Info appare la versione CodeMeter installata. Se la versione visualizzata è precedente alla 6.50, installare la versione più aggiornata del Control Center dalla seguente pagina Web (CodeMeter per utente):
Da qui scarica il programma Codemeter User Runtime per Windows.

https://www.wibu.com/de/anwendersoftware.html


Applicazione
La gestione del License Server viene effettuata dall’applicazione CodeMeter WebAdmin sul server stesso.
Sul server del License Server avvia il Control Center CodeMeter
aprendo il menu start di Windows da CodeMeter -> CodeMeter Control Center. Altrimenti nella barra di ricerca della pagina di start, immetti Codemeter 
e premi il tasto INVIO, quindi nella finestra di dialogo in basso a destra fai clic su WebAdmin.

Oppure:
Nella barra degli indirizzi del browser inserisci Localhost:22350.

In WebAdminvai a Container -> Tutti i container ->seleziona qui Allplan Cm6 nel quale è stata archiviata la licenza o le licenze-> seleziona la licenza desiderata facendo prima clic sul Product Code 999 . -> Naviga ora fino alla fine, fino all’area Cronologia trasferimento licenze.

Qui appare la data in cui la licenza è stata presa in prestito, per quanto tempo e da quale utente.

[image: ]



Avvisi
Puoi anche vedere quali utenti stanno utilizzando licenze del License Server in rete. In WebAdminvai aMonitor Licenze -> Sessioni.

Attualmente le licenze in prestito vengono visualizzate nel monitor licenze -> Sessioni solo con il numero di container; l’utente appare soltanto nella cronologia del trasferimento licenze.

Poiché la cronologia trasferimento licenzeè globale, vengono elencati tutti i prestiti, anche quelli già conclusi - ovvero quelli in cui la licenza nel frattempo è già stata restituita al server licenze.
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			Domanda:

Ho installato Allplan come nuova installazione con workgroup-manager su un nuovo computer. Dopo l'avvio di Allplan appare il seguente messaggio: The user profile "DOMINIO\Nome utente" was not found. Temporary the profile of "local" will be used. 
Questo comporta l'impossibilità di accedere ai progetti. Quale è la causa?



Risposta:

Hai eseguito l'accesso su un computer con un nuovo utente Windows e questo non esiste ancora nella gestione del workgroup-manager di Allplan. 
Spostati su un computer dove c'è un utente con diritti di amministrazione nel workgroup-manager oppure esegui il login come amministratore sul computer e creare un nuovo utente nel workgroup-manager.

Allmenu -> Workgroup-manager -> Gestisci utenti -> clic destro -> Crea utente

Nel campo "Nome utente" è possibile immettere un nome utente personalizzato con una lunghezza fino a 8 caratteri.
Nel campo "Nome utente Windows" deve essere indicato il nome utente con cui l'utente esegue il login nel computer. 
Importante: se l'utente esegue l'accesso al computer mediante un dominio, questo deve essere indicato nel campo "Nome utente Windows" e quindi, ad esempio,: DOMINIO\Utente


Ci sono un amministratore Allplan e un utente Allplan normale.
Qualsiasi utente Windows e relativo nome di login può essere configurato come amministratore Allplan assegnandogli i diritti di amministratore nel campo "Gruppo utente":
a tal proposito è necessario selezionare "Administrator"nel dropdown menu. I diritti di amministrazione possono essere assegnati a posteriori anche agli utenti esistenti.


Indirizzo email e password devono essere immessi solo se l'utente nonè membro del workgroup e deve accedere ai progetti online (Workgroup Online). 


Importante: chiudi il campo d'immissione e la overview utente con "Applica" e "OK".



Avviso:

Se l'utente è stato creato come utente Allplan, ricordati che questo utente deve anche essere assegnato ai progetti su cui può lavorare.
Informazioni dettagliate su questa procedura si trovano nel link seguente:
Abilitare l'accesso da parte dell'utente a più progetti: https://connect.allplan.com/it/faqid/0001cbd2.html
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			Domanda: 

Dopo aver acquistato / cambiato computer, come posso trasferire in modo definitivo la licenza NemSLock sul nuovo computer?



Risposta: 

Procedi come segue:

	Installa il programma con la licenza provvisoria (xxx_xxx_psd.nslock) ricevuta al momento dell'acquisto sul nuovo computer. Se non disponi di una licenza temporanea della versione corrente, richiedila al supporto tecnico.
Ora hai 30 giorni di tempo per configurare il nuovo computer, trasferire lo standard ufficio, i progetti, ecc. (istruzioni in proposito si trovano nel nostro database delle FAQ oppure sono disponibili su richiesta al supporto tecnico).
Parallelamente puoi procedere senza alcuna limitazione con i lavori sul vecchio computer, archiviare i progetti, ecc..

	Se tutto il lavoro di trasferimento è concluso, restituisci la licenza del vecchio computer da
Start -> Tutti i programmi -> Nemetschek -> Nemetschek SoftLock 2006 -> Gestione licenze
(Allmenu -> Utility -> Licenza -> Gestione licenze Softlock).

Fai clic su "Validazione -> Deregistra licenza", crea quindi il file NOME-COMPUTER.hrdwchg e invia questo file via e-mail a register@nemetschek.de. 


Suggerimento: nella finestra "Invia file cambio hardware (*.hrdwchg)", si consiglia di fare clic su "Cerca". Viene creato e salvato il file NOME-COMPUTER.hrdwchg. Viene quindi avviato Windows Explorere aperta la cartella in cui è stato salvato il file di cambio hardware. Ora puoi utilizzare tutte le possibilità offerte da Windows Explorer per salvare il file di cambio hardware in una cartella qualsiasi e allegarlo a una e-mail, copiarlo via rete su un computer che dispone di connessione Internet e inviare il file per e-mail a register@nemetschek.de.

Avviso:
generando questo file, la tua licenza Allplan sarà attiva ancora per due giorni su questo computer e poi scadrà.
Riceverai una e-mail che ti confermerà l'esito della deregistrazione. 

	Dal nuovo computer, esegui una richiesta di registrazione (register.txt) e invia il file via e-mail a register@nemetschek.de.
Se la licenza è stato restituita con successo (come descritto sopra) riceverai immediatamente una licenza definitiva per il nuovo computer. 
Caricando questo file licenza, il passaggio al nuovo computer è da ritenersi concluso.



Avviso:

Il file NOME-COMPUTER.hrdwchg viene salvato nella cartella:

fino ad Allplan 2012:
	Windows 64-bit:

C:\Program Files (x86)\Common Files\Nemetschek\NemSLock2006\License
	Windows 32-bit:
C:\Program Files\Common Files\Nemetschek\NemSLock2006\License



a partire da Allplan 2013:
	C:\ProgramData\Nemetschek\NemSLock\AllplanLicense
	oppure C:\ProgramData\Nemetschek\NemSLock\HardwareTausch
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			Domanda: 

Allplan è stato installato con una licenza Softlock temporanea ("Codice-cliente_Posto-lavoro_psd.nslock") e il suo stato viene visualizzato come "Trial" nella gestione licenze.
Come posso registrare (attivare) questa licenza?



Risposta: 

Nella gestione Softlock è necessario effettuare una richiesta di registrazione e inviarla via e-mail al server delle registrazioni register@nemetschek.de.
La licenza definitiva verrà attivata non appena verrà caricato il file di licenza ricevuto come risposta.
Successivamente sarà necessario effettuare i singoli steps descritti di seguito.



Avviso: 

	la licenza temporanea consente di avviare Allplan in modalità Trial (solitamente 30 giorni). In questo modo potrai lavorare con il programma in modo illimitato.
Non appena il periodo della Trial sarà scaduto, Allplan potrà essere avviato solo come Viewer. Anche in questo stato, sarà comunque possibile richiedere e quindi caricare la licenza definitiva.

	Se lavori con Windows Vista / 7, avvia la gestione licenze Nemetschek sempre come amministratore da 
Start (icona Windows in basso a sinistra) -> Tutti i programmi -> Nemetschek -> Nemetschek SoftLock 2006 -> Gestione licenze 
Fai un clic destro del mouse sulla voce "Gestione licenze" e seleziona "Esegui come amministratore" nel menu contestuale.




Procedura:

1. Richiedere una licenza registrata per il tuo computer 

	Passa alla barra dei task di Windows e fai clic su Start - Tutti i programmi - Nemetschek - Nemetschek Softlock 2006 - Gestione licenze(oppure Allmenu -> Utility -> Licenza -> Gestione licenza Nemslock).

Se lavori con Windows Vista, avvia la gestione licenze sempre come amministratore da Start - Tutti i programmi - Nemetschek - Nemetschek Softlock 2006 - Gestione licenze. 
Fai un clic destro del mouse su Gestione licenze e quindi su Esegui come amministratorenel menu contestuale. 

	Evidenzia il posto di lavoro (barrato in blu) che deve essere registrato.

Avviso:puoi registrare solo i posti di lavoro che hai acquistato. Se qui vengono proposti solo posti lavoro con numeri compresi fra 90 e 99 (= licenze dimostrative Trial con validità limitata), installa innanzitutto la licenza personalizzata temporanea per il posto di lavoro.

	Fai clic suRichiesta licenza. 

Viene avviato il wizard Richiesta licenza. La finestra dialogo Benvenuti nella richiesta di registrazioneoffre informazioni sulla procedura. 

	Fai clic su Avanti >. 
Viene visualizzata la finestra dialogo Dati cliente .

Avviso: per editare i dati cliente sono necessari i diritti di amministrazione. In caso contrario ti verrà mostrato un messaggio di avviso corrispondente. Chiudi la gestione licenza NemSLock e riavviala mediante l'opzione Esegui come amministratoredal menu contestuale.

	Immetti i tuoi codici identificativi e i dati del tuo ufficio: 

- Se nel Client IDappare 00000000 (otto zeri) e nel CD-Keyappare FFFFFFFF (otto lettere maiuscole) significa che il programma Nemetschek è stato installato con l'opzioneLicenza Trial con validità limitata. 
Prima di procedere alla registrazione, carica sul tuo posto lavoro la licenza personalizzata temporanea.

- Se il Client IDe il CD-Keynon corrispondono ai numeri riportati sulla bolla di accompagnamento (ad esempio errore battitura, scrittura maiuscola/minuscola non rispettata oppure simili), registra il Client-ID e il CD-Key manualmente. 

- Devono essere compilati tutti i campi. 

Presta particolare attenzione all'indirizzo e-mail indicato poiché è l'indirizzo a cui verrà inviata la licenza registrata e le informazioni sullo status della licenza. 

Avviso:verifica le registrazioni Client ID(codice cliente) e CD-Key visualizzate e confrontarle con il numero della bolla di accompagnamento Nemetschek. Per ilCD-Keyvengono di norma utilizzate solo cifre 0-9 e lettere maiuscole A-F.

Suggerimento: I codici chiave sono contenuti anche nel file di licenza personalizzato temporaneo (*_psd.nslock). Aprendo il file di licenza con un editor e spostandosi alla fine del file (blocco INFO), i codici chiave riportati a destra di KUNDE e CDKEY possono essere copiati negli Appunti e incollati nei campi d'immissione.

	Fai clic su Avanti >. 

	Seleziona il programma, la versione , il posto lavoro e fai clic su Avanti >. 

Avviso: se il Client IDnon è valido (si tratta ad esempio di una licenza Trial), la finestra di dialogo non può essere confermata con OK e viene visualizzato un messaggio corrispondente.

	Scegli la modalità con cui desideri inviare il file di registrazione e fai clic su Avanti >. 

Avvia il programma di posta elettronica... 
Viene creato e salvato il file di registrazione register.txt. Viene quindi avviato il programma di e-mail predefinito. Il file di registrazione viene automaticamente allegato alla e-mail e come indirizzo viene registrato register (please no spam) @ (please no spam) nemetschek.de. 

Salva file registrazione ... 
Viene creato e salvato il file di richiesta "register.txt". Viene quindi avviato Windows Explorere aperta la cartella in cui è stato salvato il file di registrazione. Ora puoi utilizzare tutte le possibilità offerte da Windows Explorer per allegare il file di registrazione a una e-mail, copiarlo su un computer di rete con una connessione Internet, ecc.. 

Contemporaneamente otterrai una overview dei dati con cui è stato generato il file di registrazione.

	Fai clic su Fine. 

	Esci dalla "Gestione licenze NemSLock" con "Chiudi".


Nell'arco di pochi minuti riceverai una e-mail da Nemetschek. Questa e-mail contiene le informazioni sulla procedura di registrazione e, di norma, il file di licenza registrato.

Avviso: il file di licenza registrato viene generato da un sistema automatico. Le informazioni aggiuntive oppure le note indicate nella e-mail non verranno considerate nella fase di registrazione. Invia quindi tali informazioni separatamente al tuo partner di riferimento Nemetschek.



2. Carica file licenza

Poco dopo aver inviato la richiesta di registrazione a register@nemetschek.de (vedi punto 1), riceverai il file di licenza definitivo all'indirizzo e-mail indicato.
Questo verrà caricato come riportato di seguito.

	Salva innanzitutto il file di licenza sul disco fisso oppure sul supporto desiderato.
Se la licenza è contenuta in un file Zip, decomprimerlo.

	Carica quindi la licenza facendo doppio clic sul file ("Codice-cliente_Posto-lavoro.nslock").
Il dialogo viene confermato con "Carica file licenza".

	In alternativa, il file di licenza può essere caricato anche dalla gestione licenze (Start -> Tutti i programmi -> Nemetschek -> Nemetschek SoftLock 2006 ->Gestione licenze).
Apri la "Gestione licenze Nemetschek SoftLock", fai clic su "Carica licenza" e seleziona la licenza con "Cerca...".
La procedura di caricamento viene conclusa con "Fine".


Avviso:

Su un computer non devono essere registrati più file di licenza. In questo caso infatti i posti di lavoro vengono "fusi" l'un l'altro. In questo caso solo il supporto tecnico ti può aiutare a dividere le licenze e trasferirle su altri computer.
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			Domanda:
Hai acquistato una nuova licenza e hai ricevuto un Product Key per Allplan 2016/2017. Nel tuo ufficio, tuttavia, utilizzi ancora una versione precedente di Allplan. Come puoi installare e ottenere comunque una licenza Allplan 2015 (oppure di una versione precedente) con la nuova licenza? 


Risposta:

A partire dalla versione Allplan 2016 è disponibile un nuovo sistema di protezione. Da allora la concessione licenza di Allplan è basata sul CodeMeter di Wibu Systems AG. La concessione licenza che si usava in passato via Softlock (NemSLock) oppure Hardlock (dongle) non è più disponibile per Allplan 2016/2017. Per poter attivare la tua licenza ora ricevi un Product Key via email.

La tua nuova licenza non può pertanto essere utilizzata per le versioni precedenti di Allplan (non è compatibile).

La concessione licenza delle versioni precedenti richiedeva i codici Client ID e CD Key che erano inclusi nella bolla di consegna oppure nella tua fattura. Invece di installare Allplan 2015 (oppure una versione precedente) con una licenza provvisoria, utilizza una licenza Trial idonea. La concessione licenza e l'attivazione dei moduli acquistati avverrà come in passato grazie ad una richiesta di registrazione.

Avviso:
se nel tuo ufficio è stato configurato un server licenze ed è stata acquistata una nuova licenza "License server", fai riferimento alle istruzioni separate oppure contattaci al seguente indirizzo support.it@allplan.com. Suggestivamente ti invieremo le istruzioni per collegare la tua licenza a un server licenze esistente.  

Se desideri installare Allplan 2015 oppure versioni precedenti, installa innanzitutto la versione che desideri mediante una licenza Trial.

Download Allplan:
Assicurati di installare l'ultima versione disponibile della versione Allplan di cui ha bisogno.
Il download della versione corrente di Allplan può avvenire sia da Allplan Connect che dal server FTP. 
Download da Allplan Connect:
https://connect.allplan.com/it/support/downloads.html


1. Installa Allplan con la licenza Trial 
Esegui l'installazione di Allplan. Non appena appare la finestra dialogo "Selezione informazioni licenza", seleziona l'opzione "Licenza Trial con validità temporanea" e quindi una licenza "Architettura" oppure "Ingegneria". 

Attenzione: se nel tuo ufficio è stato configurato un workgroup-manager, seleziona la licenza mediante l'opzione "Altra licenza Trial" -> Avanti. Seleziona la cartella "Italia -> Workgroup", la licenza desiderata, e quindi avvia e porta a termine l'installazione. Verifica di aver indicato le cartelle corrette.


2. Richiedi una licenza registrata per il tuo computer 
La licenza Trial vale 30 giorni e non è personalizzata.
Per questa ragione, nella richiesta di registrazione i tuoi dati personali devono essere immessi manualmente. 
I codici Client ID e CD Key richiesti sono disponibili sia nella bolla di consegna che nella fattura.

Una richiesta di registrazione avviene come segue:

Apri la gestione licenze (Allmenu -> Utility -> Licenza-> Gestione licenze). 
Evidenzia la licenza del posto lavoro e fai clic su "Richiedi licenza". Sarai guidato attraverso il menu di registrazione. 

Avviso: per editare i dati cliente sono necessari i diritti di amministrazione. In caso contrario ti verrà mostrato un messaggio di avviso corrispondente. Chiudi la gestione licenze NemSLock e riavvia Allmenu facendo un clic destro del mouse sulla sua icona e selezionando l'opzione "Esegui come amministratore" dal menu contestuale.


Immetti i tuoi codici identificativi e i dati del tuo ufficio: 
il Client IDè 00000000 (otto volte la cifra zero) e il  CD-KeyFFFFFFFF (otto "F" in maiuscolo) 

Passa al campo "Immetti Client ID" e immetti il tuo codice cliente. Questo si trova, ad esempio, sulla lettera di accompagnamento/ bolla di consegnache hai ricevuto con Allplan.
Passa al campo "CD-Key" e immetti il  tuo CD Key. Anche questo si trova nella lettera di accompagnamento. Presta attenzione alla scrittura in maiuscolo e minuscolo.

Avviso:i tuoi Client ID e CD Key sono disponibili nel campo in alto a sinistra della tua bolla di consegna. Per ilCD-Keyvengono di norma utilizzate solo cifre 0-9 e lettere maiuscole A-F.


Compila tutti i campi. Presta particolare attenzione all'indirizzo e-mail indicato poiché è l'indirizzo a cui verrà inviata la licenza registrata e le informazioni sullo status della licenza. 
Fai clic su Avanti >

Invece del posto lavoro 94, registra il posto lavoro della licenza che hai appena acquistato e quindi, ad esempio, 02, 03, 04, ecc.
Scegli la modalità con cui desideri inviare il file di registrazione e fai clic su Avanti >. 

Avvia il programma di posta elettronica... 
Viene creato e salvato il file di registrazione register.txt. Viene quindi avviato il programma di e-mail predefinito. Il file di registrazione viene automaticamente allegato alla e-mail e come indirizzo viene registrato register (please no spam) @ (please no spam) nemetschek.de. 

Salva file registrazione ... 
Viene creato e salvato il file di richiesta "register.txt". Viene quindi avviato Windows Explorere aperta la cartella in cui è stato salvato il file di registrazione. Ora puoi utilizzare tutte le possibilità offerte da Windows Explorer per allegare il file di registrazione a una e-mail, copiarlo su un computer di rete con una connessione Internet, ecc.. 

Contemporaneamente otterrai una overview dei dati con cui è stato generato il file di registrazione.

	Fai clic su Fine. 

	Esci dalla "Gestione licenze NemSLock" con "Chiudi".


Nell'arco di pochi minuti riceverai una e-mail di risposta. Questa e-mail contiene le informazioni sulla procedura di registrazione e, di norma, il file di licenza registrato.

Avviso: il file di licenza registrato viene generato da un sistema automatico. Le informazioni aggiuntive oppure le note indicate nella e-mail non verranno considerate nella fase di registrazione. 


3. Carica file licenza
Poco dopo aver inviato la richiesta di registrazione a register@nemetschek.de (vedi punto 1), riceverai il file di licenza definitivo all'indirizzo e-mail indicato.
Questo verrà caricato come riportato di seguito.

	Salva innanzitutto il file di licenza sul disco fisso oppure sul supporto desiderato.
Se la licenza è contenuta in un file Zip, decomprimerlo.
	Carica quindi la licenza facendo doppio clic sul file di licenza ("Codice-cliente_Posto-lavoro.nslock").
Il dialogo viene confermato con "Carica file licenza".
	In alternativa, il file di licenza può essere caricato anche dalla gestione licenze (Start -> Tutti i programmi -> Nemetschek -> Nemetschek SoftLock 2006 ->Gestione licenze).
Apri la scheda "Gestione licenze Nemetschek SoftLock", fai clic su "Carica - Carica licenza" e seleziona la licenza con "Cerca...".
La procedura di caricamento viene conclusa con "Fine".
	La tua licenza registrata ora appare nella gestione licenze.  Rimuovi la spunta dalla licenza Trial (ad esempio posto lavoro 94 oppure 98). Devono essere spuntate solo le tue licenze registrate.
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Javascript non è attivato! 
Questo sito web utilizza Javascript per molte funzioni come Login, Registrazione, Navigazione, Ricerca e molte altre. Di conseguenza, è necessario attivare Javascript nel tuo browser web. Sei pregato di attivare Javascript se vuoi utilizzare i nostri servizi.
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